
Release Notes

Applies to:  SpecsIntact v5.4.0.156

Released:  July 28, 2023

What's New In SpecsIntact v5.4.0.156 since v5.3.0.140

SpecsIntact Features New Supplemental Address List To Automatically Add Local Reference
Address To Section 01 42 00 'Sources For Reference Publications' For New Jobs

SpecsIntact features a new Supplemental Address List to automate the process of adding local reference
addresses to the UFGS 01 42 00 ' Sources for Reference Publications' Section for new Jobs.  When creating a
new Job from the UFGS, SpecsIntact will now add to the UFGS 01 42 00 Section the addresses for local
reference-issuing organizations saved in the Supplemental Address List.  Create, edit, and manage the new
Supplemental Address List from the newly redesigned 'Supplemental References' tab of the Reference
Processing dialog, available from the SI Explorer's Process menu.
SpecsIntact automates creating a new Supplemental Address List from any local Master whose 01 42 00
'Sources for Reference Publications' Section contains addresses for local references issuing organizations. 
Creaate the list from a Master Section with organization addresses alphabetized by organization name (as is the
UFGS 01 42 00) to alphabetize your Job 01 42 00 Sections and avoid duplicate addresses.  SpecsIntact also
allows you to create a new, empty Supplemental Address List, to which you can manually add your local
reference addressses. 
To create a new Supplemental Address List:

With any Job (or Master) selected in the SI Explorer, choose the 'Reference Processing for...' option from
the Process menu.
Select the Supplemental References tab.
With Supplemental Address List  selected at the top of the dialog, select the Generate new list option.
Select any local Master whose Section 01 42 00 includes properly tagged (REF, ORG, and OAD tags) local
reference organization addresses.  If alphabetized, this Master Section 01 42 00 can also include UFGS
(non-local) addresses, which SpecsIntact will automatically exclude.  Alternatively, choose {none] to
create an empty list to which you can manually add reference organization addresses.
Click the OK button to create a new Supplemental Address List.  If you created a new list from a Master
01 42 00 Section, SpecsIntact will indicate the number of addresses it added to the new list.

SpecsIntact stores the Supplemental Address List in the same folder as the existing Supplemental Reference
List, so moving one of these files moves them both.  Manage both files from the same Supplemental
References tab of the SI Explorer's Reference Processing dialog.

(CR 16-005)

Streamlined SpecsIntact Executable Installation

SpecsIntact 5.4.0 features a streamlined executable installation that is simpler, faster, and more reliable, while
also providing a more elegant interface.

(SPECSI-4245)



Use New Section Summary Comments To Manage Section Editing

Highlight important Section information in the new summary comments, which you can add and change from
the Comments tab of the SI Explorer's Section Properties dialog.  Section summary comments are also an
optional display column in the Explorer.  To view all Section summary comments for Jobs or Masters:  With any
Job or Master selected in the SI Explorer, choose the 'Columns...' option from the Explorer's View menu, and
then select the Summary column option at the bottom of the available display columns.

(CR 07-004)

Use Revisions When Renaming Sections

When renaming a Section, the SI Explorer now offers the option to Use Revisions for all changes, both in the
renamed Section and in any Job or Master Sections that reference it.

(CR 06-011)

SpecsIntact Supports Loss Of Display Monitor While Running

The SpecsIntact Explorer better supports disconnecting display monitors it uses while it is running. 
Disconnecting a monitor used for a SpecsIntact dialog with the SI Explorer active will no longer cause the next
invocation of that dialog to display off screen (leaving the Explorer apparently unresponsive).

(SPECSI-4323 AND SPECSI-4328)

New Option To Use Section Headers And Footers For Reports And Project Table Of Contents

SpecsIntact now features the option to use user-specified Section headers and footers for reports and project
table of contents.  To do this, select the option Use the above headers and footers for reports and project
TOCs on the Header/Footer tab of the SI Explorer's Print Processing dialog.

(CR 07-012 and CR 15-002)

SI Editor Retains And Reuses Previous Zoom Setting

The SpecsIntact Editor now saves its last selected zoom setting, reusing this setting when opening a new
Section.

(SPECSI-4332)

Editor Automatically Completes Typed Tailoring Options And Scrolls Listed Options Into View

When adding new Tailoring Options, the SI Editor will automatically and unintrusively supply the next matching
option (if any) in the list of previously used Tailoring Options, while also scrolling the list to bring into view the
matching option.  Press the Delete or Backspace key to remove the Editor's suggested test, or type a new letter
to bring up the next match in the list.

(CR 16-014)

Editor Retains Vertical Scroll Position When Undeleting Redlines



When undeleting redlined revisions, the SI Editor now maintains unchanged its vertical scrolling position. 

(CR 16-014)

Editor Validates For Reference Identifiers And Submittal Items With Too Many Characters

When validating a Section, the SI Editor now checks the lengths of all Reference Identifiers (RID tags) and
Submittal Items (SUB tags), listing in the validation log file any with too many characters to print correctly.

(CR 09-016)

Editor Adds Brackets Around Sample Text Inserted With New Tags

When adding sample text for new parts, subparts, references, ordered list items, and other tags, the Editor now
encloses the sample text in brackets.  This change makes it easier to find sample text inadvertently left in
Sections, as this text will now appear in the SpecsIntact Bracket Verification Report.

(CR 06-005)

SI Editor Remove Tags Command (Ctrl+M) Available While Editing Formatted Tables

The SI Editor keyboard shortcut to remove tags (Ctrl+M) is now available when editing inside a formatted table
cell.

(SPECSI-4093)

Future UFGS May Support Enhanced Submittal Reconciliation

SpecsIntact supports additional markup options for the 01 33 00 Submittal procedures Section, including a new
SDNUMBER attribute for Submittal (SBM) tags.  With a properly tagged 01 33 00 Submittal Procedures Section,
SpecsIntact Submittal Reconciliation will remove from the Section any text whose Submittal Description
Number is unused.

(SPECSI-4220, SPECSI-4221, SPECSI-4261, SPECSI-4272, and SPECSI-4319)

SI Explorer Correctly Handles Saved Section Comments

In the Section Properties dialog, the SI Explorer will prompt to save only Section comments that have been
modified, and will display comments only for the Section to which they apply.

(SPECSI-4249)

Formatted Tables Published To Word In Correct Locations

When Publishing UFGS Sections with tabular headers to Word format, SpecsIntact will insert formatted tables in
the correct locations in the published Word files.

(SPECSI-4250)



Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/


Release Notes

Applies to:  SpecsIntact v5.3.0.140

Released:  February 24, 2022

What's New In SpecsIntact v5.3.0.140 since v5.2.1.132

SpecsIntact Automates Multi-Level Ordered Lists

SpecsIntact 5.3 features multi-level ordered lists that renumber and re-letter automatically.  Create a new
ordered list or add a new item to an existing list by clicking the Ordered List button on the SI Editor's Tagsbar. 
After adding one list item, press the Enter and F2 keys (F2 repeats the last tag insertion) to add more list items
quickly.  While editing an item's text, increase it's indentation by pressing the Tab key, or decrease indentation
from the Editor's Format menu or the Attributes sub-menu of the right-click context menu.
SpecsIntact automatically orders lists according to UFC 1-300-02 format, with four levels of indentation as
shown below:

The new tags automate SI ordered lists, an OLI tag surrounds each list item, and an OLG tag to group OLI items
together into a single list.  Pressing the Editor's Ordered List button adds surrounding OLG tags when needed
for new list already enclosed in OLG tags.
SpecsIntact users and master text preparers can convert most manual lists in a Job or Master to use the new
automatically ordering lists.  From the SI Explorer's Process Menu, select Convert Manual Lists to Order
Automatically... then follow the prompts.  SI will convert only those lists (LST and ITM tags) adhering to UFC 1-
300-02 ordered list tagging standards).
BEFORE using the new ordered lists or converting any Job or Master to use them, ALL SpecsIntact users MUST
have SI version 5.3.  DO NOT use or convert to these automatic lists unless all affected users have already
upgraded to SpecsIntact 5.3.

Conversions to the new ordered lists are final, and cannot be undone.  SpecsIntact offers no conversion back to
the older manual lists.  For this reason, we strongly urge backing up a Job or Master before converting its
Sections to use automatically ordered lists.
By default, SI will offer to back up a Job or Master before the conversion, but his prompt is optional, and might
be turned off.  Ensure that SI prompts to back up Job or Master before deleting it or reformatting its Sections is
checked in the Options dialog, which is available from the SI Explorer's Setup Menu.



(CR 981008 and CR 10-017)

Update Job Or Master References To Latest UFGS Standards Without Losing Unlisted Or
Supplemental References

SpecsIntact now offers the option to update Job or Master references to the latest reference standards, while
also preserving any unlisted or supplemental references.
By default, SpecsIntact offers to update Job or Master references from the Unified Master Reference List
(UMRL), which contains all references used in the UFGS.  SpecsIntact first saves all Job or Master References List
(UMRL), which contains all references used in the UFGS.  SpecsIntact first saves all Job or Master references, to
ensure that it can preserve any references no in the UMRL (or other specified list).  SpecsIntact next removes
the existing references and then replaces them with the latest versions from the UMRL.  After this, SpecsIntact
will add back any missing references, first from the Supplemental Reference List (if available), and then from the
previously saved Job or Master references.  
To use this feature, select Reference Processing for Job... (or for Master) from the SI Explorer's Process
menu while working in a Job or Master.  Then, under the Action group, select the radio option to Generate new
Reference Articles but preserve unlisted references.  SpecsIntact selects the Unified Master Reference List
(UMRL) as a source reference list by default, and we recommend keeping it selected.  For experienced master
text preparers, other Masters with available reference lists are offered as the source for reference updates.

By default, SI will offer to back up a Job or Master before generating new Reference Articles, but this prompt is
optional, and might be turned off.  Ensure that SI prompts to back up before the conversion by verifying that
the option Prompt to back up Job or Master before deleting it or reformatting its Sections is checked in the
Options dialog, which is available from the SI Explorer's Setup menu.
After the optional backup prompt, SpecsIntact will stat that it must first remove the existing References in the
Reference Articles before generating new ones click OK to proceed and update your References to the latest
standards, while preserving any supplemental and unlisted references.

(CR 02-019)

Enter Key Pressed Before Ending Tag In SI Editor Adds New Line After Tag; Use Shift Enter To
Add New Line Before Ending Tag

Pressing the Enter key with the cursor immediately in front of the ending tag will now add a new line after the
ending tag, rather than before it.  Hold down the Shift key while pressing Enter to add the new line before the
ending tag (the previous Editor functionality).
SpecsIntact tags rarely include new lines inside them, so this new feature will save time while editing most
SpecsIntact content.  Users who would rather keep the older functionality cal still do so, however.  From the
Editor's Tools menu, select Options... and then the Edit tab.  Uncheck the option Enter key pressed at end of
tag closes that tag, and then press the OK button.

(SPECSI-4125 and SPECSI-4126)

Zoom In The SI Editor By Turning Mouse Wheel While Holding Ctrl Key

Zooming in or out while editing a Section in the SI Editor is easier now.  Using a mouse with a wheel, turn the
mouse wheel while holding the Ctrl key to zoom in or out as appropriate (consistently with other Windows
applications that support this feature).



(SPECSI-4214)

SpecsIntact Editor Automatically Re Selects Last-Used Printer

Printing a draft copy to PDF format or a printer is easier in the SI Editor, as it will automatically reselect the last
printer used in it.

(CR 16-006)

Open Referenced Sections Or Hyperlinks While Editing In Table

The SI Editor now offers and easier way to open a referenced Section while editing the reference for it in the
cell or a formatted table.  Likewise, easily open a URL hyperlink while editing it in a table cell.  To do this, right-
click inside the Section reference or hyperlink while editing it in a table cell, and select Open Referenced
Section or Browse to Hyperlink, as appropriate.

(SPECSI-4209)

Notes Valid Inside Submittal Tags

Specifier notes are now valid inside Submittals (SBM) tags.  The UFGS 01 33 00 Submittal Procedures Section
now validates correctly with specifier notes visible.

(SPECSI-4223)

SpecsIntact Prints And Published Only Selected Reports

SpecsIntact prints and publishes only those reports selected on the Reports tab of the SI Explorer's Print
Processing dialog.  Printing or publishing the Submittal Register, or reconciling References, Submittals, or
Addresses will not automatically print or publish unselected reports.  These features still automatically generate
verification reports in the Processed Files folder, but SpecsIntact will no longer print or publish them unless
selected.

(CR 02-020)

SpecsIntact Adds Bookmarks (Hyperlinks) From Project Table Of Contents To Sections When
Publishing Them To PDF Format

When publishing Sections and Job (or Master) tables of contents to PDF format with bookmarking, SpecsIntact
will automatically add bookmarks from these PDF tables of contents to the PDF Sections.  These bookmarks will
work only in a PDF viewer that supports Bookmarks, such as Adobe Reader or Acrobat.

(SPECSI-4196)

SpecsIntact Help Topics Open In Default Browser

SpecsIntact now opens all integrated help topics in the default web browser, rather than a dedicated help
window.  These help topics are still local files, so they will load quickly with or without internet access.  This
change eliminates error messages when closing the software after accessing a help topic.

(SPECSI-4019 and SPECS-4239)



SpecsIntact Master Reference Processing Works Correctly

Master text preparers can remove all references and generate new Reference Articles.  This feature was
unavailable in SpecsIntact 5.2.

(SPECSI-4170)

SpecsIntact Explorer More Reliable

The SI Explorer works more reliably while connecting a new version of the Unified Facilities Guide Specifications
(UFGS), as well as in other situations.

(SPECSI-4212)

SpecsIntact Editor More Reliably Saves Hidden, Tailored Tables

The SI Editor more reliably saves hidden, tailored tables, as it no longer sometimes fails when doing this. 

(SPECSI-4193)

SpecsIntact Editor More Reliable When Printing

The SI Editor is more reliable, especially when printing draft copies of Sections and during draft print preview.

(SPECSI-4155 and SPECSI-4222)

Editor Pastes Tag Attributes Into Formatted Tables

When copying and pasting tags with attributes (TAI and URL) into a table cell from outside it, the SI Editor now
pastes the full tag with attributes.

(SPECSI-4210)

Editor Correctly Ends Attribute-Justified Text When Printing

The SI Editor correctly resumes left justification after printing tags that are right or center-justified via tag
attributes.

(SPECSI-4147)

SpecsIntact Reports Errors Processing Write-Locked Files

SpecsIntact correctly indicates when a Section cannot be processed because it is write-locked.

(SPECSI-4215)

SpecsIntact Prints/Publishes Attributes When Showing Tags

When printing or publishing to PDF with tags showing, SpecsIntact correctly prints/publishes tag attributes for
tags that have them.

(SPECSI-4175)



Reconciliation Options Correctly Disabled For Masters

SpecsIntact correctly disables Address, Reference, and Submittal Reconciliation in the Print Processing dialog
for Masters, to which these reconciliation options do not apply.

(SPECSI-4216)

SpecsIntact Installation Clarifies Need To Not Cancel

The SpecsIntact executable installation reminds users not to cancel until the installation has finished. 

(SPECSI-4108)

Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/


Release Notes

Applies to:  SpecsIntact v5.2.1.132

Released:  March 16, 2021 (Maintenance Release)

What's New In SpecsIntact v5.2.1.132 since v5.2.0.124

SpecsIntact Editor Saves And Validates Sections Correctly

The SpecsIntact Editor correctly validates and saves Sections that contain formatted tables in atypical locations,
such as prior to Part 1.

(SPECSI-4143)

Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/


Release Notes

Applies to:  SpecsIntact v5.2.0.128

Released:  February 25. 2021

What's New In SpecsIntact v5.2.0.128 since v5.1.0.106

SpecsIntact Lite Replaces SI ThinApp Version

SpecsIntact Lite offers nearly complete SpecsIntact functionality without an installation, replacing the SI
ThinApp version.  SpecsIntact Lite works more reliably with better feature support than SI ThinApp, and it uses
only the same software files a traditional SI Installation provides.  SI Lite provides all SpecsIntact features except
native PDF publishing using the SpecsIntact PDF printer.  You can install the SI PDF Printer manually for full
SpecsIntact support, however. To make this easier, SpecsIntact provides a new menu option to install the
SpecsIntact PDF printer automatically, which is available from the SI Explorer's Setup menu.  Windows may
require elevated privileges to install the SI PDF printer, but SpecsIntact offers the options to try it both with and
without elevation.  To obtain SpecsIntact Lite, choose the SpecsIntact Lite option at the top of our Download
Form, available at the following location: https://si.ksc.nasa.gov/sidownloads/siversion/sidown.htm. 
Instructions for using SI Lite are included in the downloaded zip format file.

(CR 09-019, SPECSI-4066, SPECSI-4067, SPECSI-4070, SPECSI-4071, and SPECSI-4083)

New SpecsIntact Software Usage Agreement

Accepting a SpecsIntact User Agreement is now a requirement for installing SpecsIntact or running SpecsIntact
Lite. The new agreement defines the terms that govern SpecsIntact usage.  As before, SpecsIntact and the
Unified Facilities Guide Specifications (UFGS) are available free of charge.

(SPECSI-4094)

New Section Reference Wizard

The SpecsIntact Editor features a new Section Reference Wizard for referencing other Sections from the current
project or any available Master. After adding a new Section reference, the wizard will check for that Section in
your Job or Master, offering to add it automatically if it is not already present. The SI Editor will display the
Section Reference Wizard whenever adding new Section Reference (SRF) tags. Optionally disable the Section
Reference Wizard in the Editor's Options dialog, available from the Tools menu: On the Edit tab, uncheck the
option, Use Submittal and Section Reference Wizards.

(CR 16-010)

Copy And Paste Multiple Formatted Table Cells

The SI Editor now supports copying multiple formatted table cells and pasting them into other SI tables, or into
other applications, such as Microsoft Excel spreadsheets and Word tables. After selecting multiple table cells in
the SI Editor, type Ctrl-C to copy the cells with embedded tags, or Ctrl-E to copy them without tags.

https://www.wbdg.org/tools/specsintact/KnowledgeBase/Frequently_Asked_Questions/FAQ_ConvertMicrosoftWordFile_IntoSpecsIntact.htm


Paste the cells into another SI table in several ways, including any one of these:

(CR 12-005)

Set Row Heights And Column Widths For Formatted Tables

The SI Editor now features the ability to specify the height for one or more table rows, and the width for one or
more columns, automatically resizing the table as needed.

To set the height for all rows in a table, right-click on the table, select the Row Height... menu option, type in
the new height, and then select the OK button. Set the heights for only some rows by selecting them first, and
then following the same steps. The Editor will apply the same height for all specified rows, except that it may
adjust the final table row height to fit the table evenly within the lines of the surrounding Section.

Set the widths for one or more columns in a similar manner, but choose the Column Width... menu option
instead. The Editor will set the same width for all specified columns, subject to the available margins.
Both the Row Height... and Column Width... menu options are also available from the Editor's main Table
menu. The width units are 1/96th of an inch, so the added widths of all columns in a full-page (6.5-inch wide)
table would be approximately 624.

(CR 13-007)

New Editor Keyboard Shortcut F2 Repeats Last Tag Insertion

The SI Editor will repeat the previous tag insertion when the F2 key is pressed. The F2 keyboard shortcut will
work for most SI tags, including the LST and ITM tags with negative indentation. It will not repeat the insertion
of Tailoring tags, however, and all normal tag rules still apply.

(CR 10-008)

Editor Keyboard Shortcut To Remove All Revisions Now Ctrl-L

The keyboard shortcut to remove all Revisions in the SI Editor is now Ctrl-L instead of Ctrl-A.

(SPECSI-4013)

SI Welcome Dialog Streamlines New User Experience

For new users, SpecsIntact will display a single welcome dialog offering the most commonly used SI options.
From this dialog, SI users can choose to create a new Working Directory in their Documents folder,

Click in the table cell where you want to start pasting, press the Esc (Escape) key to cancel the cell edit,
and then type Ctrl-V to paste the copied cells.

1.

Select the cells to replace in the destination table, and then type Ctrl-V. This method replaces at most the
selected cells, even when pasting more cells than were selected.

2.

While editing in the destination table, right-click in a table cell OTHER THAN THE ONE BEING EDITED, and
select the Paste menu option.

3.

The Editor supports undoing or redoing the pasting of formatted table cells, and applies Revisions when
in use. The Editor also supports pasting tabular data copied from other applications, such as Microsoft
Excel spreadsheets and Word tables.

4.

https://www.wbdg.org/tools/specsintact/KnowledgeBase/index.htm#t=Release_Notes%2FSI-v5_2_0_128.htm 2/6



automatically download and connect the UFGS master, allow SpecsIntact to count them, and create Desktop
shortcuts for the SpecsIntact Explorer and Editor. Alternatively, users can still choose each option individually, as
in previous SI versions.

(SPECSI-4067, SPECSI-4070, SPECSI-4071, and SPECSI-4083)

New SI Versions Offer To Create Desktop Shortcuts

When first run, new versions of SpecsIntact will offer to create automatically Desktop shortcuts for the
SpecsIntact Explorer and SI Editor. 

(SPECSI-4066)

Menu Option To Install SpecsIntact PDF Automatically

The SpecsIntact Explorer features a new menu option to install the SpecsIntact PDF printer automatically for SI
Lite users or anyone needing to reinstall it. From the Setup menu of the SI Explorer, select Install SpecsIntact
PDF Printer... SpecsIntact offers the option to install the printer either with or without elevated privileges
(Microsoft Windows typically requires elevated privileges to install the printer, but the installation may succeed
without elevation if the printer driver is already available). For installed SI versions, this new menu option works
only if the SI PDF feature was included during a previous installation.

(SPECSI-4069)

Project Tables Of Contents Include Section Dates

Project tables of contents created with SI 5.2 will display Section dates between the Section number and title,
as do Master tables of contents. The dates will appear whenever showing Section dates during print processing
(the option to Show Section dates is available on the Options tab of the SI Explorer Print Processing dialog).

(CR 15-010, SPECSI-4020, and SPECSI-4021)

Future UFGS Section Dates Will Show Change Information

An upcoming UFGS release will include both Section dates and Change dates in the Section date (DTE) tags for
those Sections having Change information. When showing Section dates during print processing, Change dates
will be visible in the Sections and in all tables of contents. The Change information will also appear in the SI
Explorer's optional Section Date column.

(CR 15-010, SPECSI-4009, SPECSI-4010, SPECSI-4021, and SPECSI-4030 )

SpecsIntact Will Issue Warning If Incompatible With New UFGS

When offering the option to download a newer UFGS version, SpecsIntact will now issue a warning if the new
UFGS requires newer SI software. The warning, which will state the minimum SpecsIntact version required for
the new UFGS, will be available in SpecsIntact 5.2 and future versions.

(CR 12-001)

SI Explorer Displays Job Columns Correctly In Right Pane

3/25/25, 10:59 AM SI v5.2.0.128



The SpecsIntact Explorer will consistently display the correct columns when showing all Jobs in its right
windowpane, even after actions that formerly removed all columns but the Job name.

(SPECSI-3795)

New SI Installations Support Disabling Checks For New Software

Administrators installing SpecsIntact can disable for all users on a computer SpecsIntact's automatic checks for
newer SI software. To prevent SpecsIntact from automatically checking for new SI software, do the following
when installing SpecsIntact:

When the newly installed SpecsIntact software runs for the first time, it will turn off automatic checking for new
SI software.

(CR 18-0001)

Run Multiple Instances Of SI Explorer On Windows Server

Multiple instances of the SpecsIntact Explorer will now run simultaneously on Windows terminal servers and
other Windows server operating systems. Enable this feature manually for other Windows versions as follows:

(SPECSI-4064)

MSI Installations Uninstall Previous Versions

To simplify upgrading, the SpecsIntact MSI installation will automatically uninstall a previous SpecsIntact MSI
installation before installing the new software.

(SPECSI-4075)

SI Explorer Saves Setting For Identical Tailoring Options

When tailoring in the SI Explorer, SpecsIntact will now save and reuse the setting to apply a selection in one
Section to identical Tailoring Options in other tailored Sections.

(SPECSI-4103)

SpecsIntact Prevents Most Punctuation In Working Directories

SpecsIntact will no longer add new Working Directories containing punctuation other than underscores, spaces,
periods, and hyphens. Existing Working Directories with punctuation will be unaffected unless added again; but

Create the following registry key(s):
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SpecsIntact\Settings.

1.

In the Settings key, create a new string value DisableSoftwareUpdateChecks.2.
Edit this string, assigning it the value 23.

Create the following registry key(s):
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SpecsIntact\Settings

1.

In the Settings key, create a new string value AllowMultipleInstances2.
Edit this string, assigning it the value true (lower case) Multiple instances of the SI Explorer will now run
simultaneously.

3.



we strongly recommend renaming and reconnecting them to avoid errors publishing to PDF format.

(SPECSI-3998)

SI Explorer Search More Reliable

The SI Explorer will search Sections more reliably and consistently by removing carriage returns from text
before searching for it.

(SPECSI-4095)

Add Sections Dialog Defaults To Job Primary Master

When adding Sections to a Job via the Add Sections dialog, SpecsIntact will initially display Sections from the
Job's primary Master, rather than from the SI default Master (if different).

(SPECSI-4097)

Submittal Procedures Section Tailored In New Job

When creating a new Job and adding the Submittal Procedures Section 01 33 00 automatically, SpecsIntact will
now offer to tailor this Section along with any other added Sections.

(SPECSI-3876)

Redlined Submittal Descriptions Processed Correctly

SpecsIntact will correctly process redlined Submittal Descriptions in the Submittal Procedures Section,
eliminating erroneous Submittal Verification Report listings.

(SPECSI-3994)

Prompt To Reload Changed Network Job Or Master Clarified

The SI Explorer prompt to reload a network Job or Master whose contents have changed is easier to
understand.

(SPECSI-3995)

Double-Clicking Column Headers In SI Explorer Works Correctly

Double-clicking a column header will no longer cause the SI Explorer to open a selected Section.

(SPECSI-3229)

Editor Displays Tailoring Options For Masters With Long Names

When adding Tailoring Options, the SI Editor will correctly display the available options for Masters with longer
names. Also, for a Section that is not in a Job or Master, the Editor will correctly disable the second tab in the
Add Tailoring Options dialog.

(SPECSI-3992 and SPECSI-3993)



Undo Context Command Available To Undo Added Sections

The SI Explorer once again features an Undo command to cancel adding or overwriting Sections in the Contents
of Job window in the Add Sections dialog. Before selecting OK after choosing a Section to add or overwrite,
right-click the added Section in the Contents of Job window to see this command option.

(SPECSI-3997)

Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/


Release Notes

Applies to:  SpecsIntact v5.1.0.106

Released:  January 10, 2020

What's New In SpecsIntact v5.1.0.106 since v5.0.0.098

SpecsIntact Is Faster

SpecsIntact is faster, especially when accessing network Working Directories and Jobs and Masters residing on
them in the SI Explorer. To improve performance, SpecsIntact 5.1 stores more information in project lists of
Sections (pull tables) than did previous SpecsIntact versions.  After use by SpecsIntact 5.1, Jobs and Masters
opened in SpecsIntact Explorer 4.x (or as sources in the Add Sections dialog of SpecsIntact 5.0) will display
additional characters in the Section titles, and may not work correctly in some cases.  To eliminate this issue
in SpecsIntact 5.0, simply select the Job or Master in the SI 5.0 Explorer before adding Sections from it, OR add
Sections by dragging and dropping them rather than through the Add  Sections dialog.  In SI 4.x, regenerate the
pull table: Select Release Processing from the Process menu, ensure that the option Project List of Sections
(Pull Table) is selected, and then click OK.
To provide full compatibility with older SpecsIntact versions while sacrificing performance, SI 5.1 users can
disable SpecsIntact Job and Master optimization.  In the Options dialog available from the Setup menu, uncheck
the option, Optimize performance for network Jobs and Masters to create pull tables compatible with earlier
versions of SpecsIntact.  Doing this will greatly reduce SpecsIntact performance, however, so we do not
recommend this, especially if you access Jobs and Masters on network Working Directories. To improve
performance, the SI Explorer will not read titles and other data for Jobs located on network Working
Directories until you select the Job, or mouse over it in the left pane of the SI Explorer. Until read, Job titles will
display "(Select Job to See Job Title)."  Although this provides substantial performance benefits, you can disable
this option to force SpecsIntact to read information for all Jobs when opening network Working Directories.  To
disable this performance feature, uncheck the option, "Optimize performance for network Working Directories"
in the Options dialog available from the Setup menu. Doing this will greatly reduce SpecsIntact performance,
however, so we do not recommend this, especially if you access Jobs and Masters on network Working
Directories. 

The SpecsIntact Explorer is faster to complete numerous operations with connected network Working
Directories and projects, including:

Opening or refreshing the SI Explorer
Selecting/opening a Job or Master
Creating new Jobs and Masters
Deleting Jobs and Masters
Renaming Jobs and Masters
Duplicating Jobs and Masters
Backing up and restoring Jobs and Masters
Specifying properties for Jobs and Masters
Changing PDF or Word folders for Jobs and Masters



Loading the Connect Masters dialog
Adding Sections
Deleting Sections
Executing Revisions
Renaming Sections
Tailoring Sections
Specifying SpecsIntact options

The SpecsIntact Editor is faster at saving Sections with formatted tables, especially in network locations.

(SPECSI-3721, SPECSI-3796, SPECSI-3797, SPECSI-3798, SPECSI-3799, SPECSI-3800,

SPECSI-3813, SPECSI-3858, SPECSI-3862, SPECSI-3865, SPECSI-3867, SPECSI-3868, and SPECSI-3880)

Master Preparers Should Disable Network Job And Master Performance Feature For SI 5.0
And 4.X Users

Master text preparers with customers still using SpecsIntact 5.0 or earlier should disable SpecsIntact network
Job and Master optimization until all users have upgraded to SpecsIntact 5.1 or later.  In the Options dialog
available from the SI Explorer's Setup menu, uncheck the option, Optimize performance for network Jobs and
Masters to create project lists of Sections (pull tables) compatible with earlier versions of SpecsIntact.  Doing
this will greatly reduce SpecsIntact performance for network Jobs and Masters, however, and somewhat reduce
performance for local Jobs and Masters.  We recommend re-enabling this option once all users have upgraded
to SpecsIntact 5.1 or later.

Users of earlier versions of SpecsIntact who receive Masters generated with this new SI 5.1 performance
feature can eliminate issues caused by it, however.  In SpecsIntact 5.0, simply select the Master in the SI 5.0
Explorer before adding Sections from it, or add Sections by dragging and dropping them rather than through
the Add Sections dialog.  In SI 4.x, regenerate the pull table for the Master: Select the Master in SI 4.x, and then
select Release Processing from the Process menu; ensure that the option Project List of Sections (Pull Table) is
selected, and then click 'OK.' SpecsIntact 4.x and 5.0 users need to complete these steps only one time, as long
as the Master is not accessed again using SpecsIntact 5.1.  

(SPECSI-3721, SPECSI-3796, and SPECSI-3880)

SpecsIntact Accessibility Improved

The SpecsIntact Explorer features better keyboard navigation and an improved appearance for those using a
Windows high contrast setting.

(SPECSI-3053, SPECSI-3370, and SPECSI-3516)

Drag-And-Drop Or Copy Files From SpecsIntact Explorer

Drag and drop or copy and paste Sections or other files from the SpecsIntact Explorer to other Windows
applications that support this capability, such as the Windows Desktop and File Explorer, and Outlook mail
messages. Copy and paste selected files and Sections using the standard Windows keyboard shortcuts Ctrl-C
and Ctrl-V respectively, or select the new Copy command from the Sections menu.

(CR 07-006, SPECSI-3360, SPECSI-3623, and SPECSI-3724)

Save And Display User Name Of Last Section Editor 



SpecsIntact now offers the option to save the Windows user name of the last person to edit a Section and to
display this user name in the SI Explorer.  To save all last user names for people editing a Job or Master, each
person working on it needs to enable the option to Save user name in Section Properties when saving
Sections in the SI Explorer's Options dialog, or the option Save user name in Section properties on the Save tab
of the SI Editor's Options dialog.  With this option enabled, the Editor will save the user name of the last person
to save Sections.  Likewise, the SI Explorer will also do so when making significant changes to Sections, such as
executing Revisions, removing English or Metric units, and making text replacements.  To display the last editor
in the SI Explorer, select the Last Edited By column in the Select Columns dialog.  To remove all saved last user
names, select the option Delete all Section properties during release processing for a Job or Master.

(CR 17-002, SPECSI-2760, SPECSI-2761, SPECSI-3428, SPECSI-3429, SPECSI-3430, SPECSI-3431,

SPECSI-3569, SPECSI-3570, SPECSI-3571, SPECSI-3678, SPECSI-3693,

SPECSI-3740,  SPECSI-3777, SPECSI-3778, and SPECSI-3779)

Select Tailoring Options From Default Or Primary Master

When adding new Tailoring Options in a Master that is not the default, the SI Editor now displays a second tab
with a list of the Options used in the default Master.  If adding Tailoring Options to a Section in a Job, the
second tab will display the Options used in the Job's primary Master.  If the default or primary Master does not
yet have a list of Tailoring Options, the Editor will also offer to create the list.  Master text preparers can also
create the Tailoring Option list automatically during release processing by selecting the 'Tailoring Option List'
option.

(CR 12-009, SPECSI-3377, SPECSI-3378, SPECSI-3379, SPECSI-3627,

SPECSI-3636, SPECSI-3637, SPECSI-3774, and SPECSI-3775)

Relocate Section Templates

SpecsIntact now permits storing SI Section and Document templates in a folder other than the default
Working Directory.  To change the location, choose the 'Change' button next to the new Templates folder
location on the 'File Locations' tab of the SI Explorer's Options dialog.

(CR 02-037, SPECSI-2034, SPECSI-3639, SPECSI-3640,

SPECSI-3641,SPECSI-3655, and SPECSI-3656)

Reset File Locations To Default Values 

SpecsIntact now offers the option to reset all file locations to their default values.  To do this, select the
'File locations' option in the 'Reset Settings' dialog, available from the SI Explorer's Setup menu.

(SPECSI-3773)

SpecsIntact Offers To Open Third-Party Location For Sections

For Jobs or Masters with Sections managed outside SpecsIntact, the SI Explorer will offer and optionally attempt
to open a third party file location for the Sections when initially opening the Job or Master.  SpecsIntact will do
this automatically for Jobs and Masters designated with a remote 



location, and with the option selected, "Sections are stored remotely in the following location:"  This option is
available on the Options tab of the Job or Master Properties dialog.  

(CR 15-003, SPECSI-3247)

Double-Click To Open Section In Attachment List

In the SI Editor, double-click a Section in the Attachment List report (ATTACHMT.RPT in the Process Files folder)
to automatically open the Section and position to the listed attachment.  You can also access this feature by
selecting "Open Referenced Section" from the context menu after 
positioning in the referenced Section number.

(CR 11-018, SPECSI-3368)

Exported Tailoring Option List Includes Preparing Activity

Exported Tailoring Option lists will now include a column showing the Preparing Activity for each Section.

(CR 11-004 and SPECSI-3375)

Backup Option Available Before Removing English Or Metric Units

SpecsIntact will first offer the option of backing up a Job or Master before removing English or Metric units
from its Sections.

(CR 08-003 and SPECSI-3498)

SI Explorer Error Messages Written To User Profile Folder

The SI Explorer will now write error messages to the file ErrorLog.log in the AppData roaming profile folder
instead of the SpecsIntact software folder. For most users, this will be the
C:\Users\USER_NAME\AppData\Roaming\SpecsIntact\ErrorLog folder.

(SPECSI-3953)

Editor Shows Submittal Hints

When the mouse cursor hovers over a Submittal item, the Editor will now indicate whether the item appears in
the Submittal Article and if so, the Submittal Description number(s) and approval requirements for the
Submittal item.

(SPECSI-3540)

Editor Uses Highlighted Text As Default URL

The SI Editor will now automatically use highlighted text as the default URL attribute when adding URL tags.

(CR 12-011 and SPECSI-3369)

Close Editor Document With Keyboard Shortcut Ctrl-W

Typing the new keyboard shortcut Ctrl-W will close the currently active document in the SpecsIntact Editor.



(SPECSI-3303)

Undo, Redo, And Select All Available Editing Header And Footer 

The options to undo, redo, and select all text are now available when editing headers and footers in
the Header/Footer tab of the Print Processing dialog.

(SPECSI-2811, SPECSI-3399, and SPECSI-3405)

Read-Only Attributes Removed For Added Sections

When adding Sections to Jobs or Masters via the Add Sections dialog, SpecsIntact will now remove any read-
only attributes on the Sections.

(SPECSI-3957)

Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

3/25/25, 10:59 AM SI v5.1.0.106

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/


Release Notes

Applies to:  SpecsIntact v5.0.0.098

Released:  March 25, 2019

What's New In SpecsIntact v5.0.0.098

New Installation Options

Two alternative options are now available for installing SpecsIntact.  For administrators who manage
SpecsIntact installations for multiple customers, SpecsIntact now features a new Windows Installer (MSI)
installation package for better integration with software deployment tools. SpecsIntact also features its
traditional installation package, but the network and workstation installations are no longer available.
Both installation packages support only local installations.  
As with previous versions, the traditional SpecsIntact 5 installation supports installing same or newer versions
over existing SpecsIntact installations; and it also supports side-by-side installations of different SpecsIntact
versions.  The new MSI installation package does not support these options, as it requires that previous
SpecsIntact MSI installations be removed before installing newer versions.  We recommend NOT installing
SpecsIntact 5 over a previous version of SpecsIntact 4.6.2 or earlier.  If you wish to have both SpecsIntact 5 and
an earlier version of SpecsIntact installed, install SpecsIntact 5 to a different folder location than the earlier
SpecsIntact version.  

We also recommend NOT mixing the MSI and traditional SpecsIntact installations on the same computer.  If you
wish to switch from the SpecsIntact MSI installation to the traditional SI installation, or vice versa, we
recommend uninstalling the previous version first, and then installing the alternative version.
For those who choose to install the SpecsIntact PDF printer, SpecsIntact now supplies a PostScript printer driver
published by Microsoft.  Windows may prompt for permission to install this driver during the installation
process.

(CR 11-008 and SPECSI-3499)

SpecsIntact Explorer

The SpecsIntact Explorer has a new look and feel, with many new productivity-enhancing features.

(CR 09-019)

Resizable Dialog Boxes

The SpecsIntact Explorer now features many resizable dialog boxes, including the Add Sections dialog.  Look for
the dotted gripper in the lower right corner of a dialog box, and drag this gripper to resize the dialog.

(CR 04-029)



New Toolbar Buttons

The SI Explorer features a new toolbar with larger, more visible buttons and explanatory text.

(CR 09-019)

Drag And Drop From SpecsIntact Explorer To Desktop, Windows Explorer Or Other
Applications

The SI Explorer now permits dragging and dropping Sections and other SpecsIntact documents to the desktop
or other Windows applications, such as the Windows/File Explorer, an Outlook E-mail message, or the
SpecsIntact Editor.

(CR 07-006, SPECSI-3283 and SPECSI-3284)

New Color Choices For Job, Master, And Document Icons

SpecsIntact now supports a large number of color choices for Job, Master, and document icons.  To select a new
color, right-click on any icon in the SI Explorer, and select the Icon Color for… menu item.  Choose a default
color, or Custom Colors, and then the drop-down arrow next to the currently selected color for many more
color choices.

(CR 09-019)

Optionally Redline When Tailoring In The SI Explorer

The SpecsIntact Explorer now features the option to redline Tailoring Options instead of deleting them.  Select
the option to Use Revisions when tailoring to enable this feature.

(CR 01-040 and CR 09-013)

Print With Tailoring Tags Visible But Other Tags Hidden

SpecsIntact now features the option to print Tailoring tags only, while hiding other tags.  To use this feature,
unselect the Tags option and select the option Tailoring tags (when hiding tags)' in the Show group box on the
Options tab of the Print Processing dialog.

 (CR 971008 and 15-006)

SpecsIntact Sorts Reference Identifiers In Natural Order

SpecsIntact now sorts Reference Identifiers (RIDs) in natural, alphanumeric order when adding them to Section
Reference Articles or Reference lists.  For example, using this new natural order sort, NFPA 70 would appear
before NFPA 101, because 70 is a lower number than 101.  The SI Editor will also display RIDs in this same
natural order in the Reference Wizard.

(CR 02-025 and CR 03-036)

New Attachment List Report



SpecsIntact now offers a report of all attachments (designated with ATT tags) in a Job or Master.  Select the
Attachment List option on the Reports tab of the Print Processing dialog to produce this report.

(CR 11-018)

SpecsIntact Reports Duplicate Submittal Items In Text For Masters

On the Submittal Verification Report for Masters, SpecsIntact now reports Submittal items appearing multiple
times in the text of any one Section. This new verification feature will be available for Jobs in a future
SpecsIntact release.

(CR 10-002)

Export And Access Tailoring Options Or Submittal Register Data Easily

Export Tailoring Options and Submittal Register data more easily in SpecsIntact 5. Both options are available
from the context menu available by right-clicking on any Job or Master.  The SI Explorer will now display these
exported files in the Exported Files folder under the corresponding Job or Master.

(CR 11-009)

Export Search Results To HTML Table

After performing a search or replacement, the SI Explorer now permits exporting the search results to a tabular,
formatted HTML file.  This option is available from the File menu, and from the context menu available by right-
clicking on a Job or Master.  The SI Explorer will display these exported files in the Exported Files folder under
the corresponding Job or Master.

(CR 15-004)

Optionally Exclude Redlines And Notes When Searching And Replacing In SI Explorer

Optionally exclude redlines and notes when searching and replacing text in the SpecsIntact Explorer.  Select
these options in the new Search and Replace dialog, available from the File menu, or by right-clicking on any
Job or Master.  

(CR 16-003 and CR 10-019)

SpecsIntact Displays Number Of Search Occurrences In Each Section

SpecsIntact now displays the number of occurrences of a search term in each Section in which the term occurs.
 This option is available by default. To select or unselect it, search for a term in any Job or Master.   In the search
results in the right pane of the SI Explorer, right-click and select the Column Headers… menu item, and then in
the Column Headers for Results Files dialog, choose the Occurrences option, and then click OK.

 (CR 16-007)

Editor Defaults To Most Recent Explorer Or Editor Search Term

When searching or replacing in the SI Editor, the default search term will be the most-recently-used search term
in either the SI Explorer or Editor.



(CR 10-012)

Search For Tags By Attribute Value In SI Editor

The SI Editor now permits searching for tags that contain user-specified attributes, such as, for example,
searching for Tailoring Option tags that contain only the 'ARMY,' 'NAVY,' or 'NASA' attribute.

(CR 08-006)

Ignore Tags Searching In SI Editor With Tags Visible

The SI Editor now permits ignoring tags when searching for text, even when tags are visible.  Select the option
to Ignore tags in the Editor's Find dialog to use this feature.  This option is selected automatically when tags
are hidden, and is not available when replacing text.

(CR 11-001)

Open Windows Explorer At Any Job Or Master Folder

SpecsIntact makes it easy to open Windows Explorer at any Job or Master.  Right-click on a Job or Master folder
or subfolder in the left pane of the SI Explorer, and select Open in Windows Explorer at the bottom of the
context menu.

(CR 09-019)

Move Back And Forward In SpecsIntact Explorer

You can now move back and forward to previously selected Job and Master folders in the SpecsIntact Explorer.
 Click on the Back' and 'Forward buttons at the top of the left pane of the SI Explorer, or right-click in the left
pane, and choose either Go Back or Go Forward.  The 'Go Forward' command will be active only while you are
actively going back, and neither command will be active when you first start the SI Explorer.

(CR 17-005)

Previously Tailored Options Automatically Selected For Subsequent Tailoring

The SI Explorer will automatically save and reuse any previous tailoring selections for a Job or Master. Options
previously selected for tailoring will be selected automatically for tailoring each time the Explorer displays the
Tailoring Options dialog for the same Job or Master.

(CR 06-020)

Quickly Locate Any Section, Document, Job, Or Master In SpecsIntact Explorer

You may now locate a Section by typing the first digits of the number in the text field at the top right of the
SpecsIntact Explorer.  Use this feature to navigate more quickly within large Jobs and Masters.  You can also use
this feature to find any other document, Job, or Master when these items are visible in the right pane of the SI
Explorer.

(CR 15-005 and SPECSI-2979)



Add A Final Blank Page To Sections Ending On Odd Page Numbers

To better support double-sided printing, you may now optionally add a final blank page to any Sections or
Section tables of contents that end on odd page numbers. To select this option for any Job or Master,
choose Insert blank pages for double-sided printing on the Options tab of the Print/Processing dialog.

(CR 09-026)

Headers And Footers Easier To Customize

Customize headers and footers more easily using separate left, center, and right-justified editing fields.
SpecsIntact no longer requires or supports the special pipe symbol (|) as a delimiter separating the separately
justified portions of header and footer lines.

(CR 16-008)

Remove English Or Metric Units

SpecsIntact now permits removing unused English or Metric units for any Section, or from an entire Job or
Master.  To do this. select the Remove English/Metric Units command from the File menu (for entire Jobs and
Masters) or from the Sections menu (for one or more selected Sections).  For Jobs using only one unit of
measure, SpecsIntact permits removing only the unused units of measure.

(CR 08-003)

Publish Sections To Most Current Word Open XML Format

When publishing Sections to Word format, SpecsIntact will now create these files in the most current Microsoft
Open XML (.docx) format. SpecsIntact will still display and allow editing of edit older (.doc) Word files, but will
no longer create them.

(CR 12-002)

New Dialog For Folder And File Browsing

When browsing for files or folders, SpecsIntact now features a more modern browse dialog consistent with
Windows standards.

(CR 01-023)

SpecsIntact Saves And Reuses Most Recent SI Printer Selection

Each time it starts, SpecsIntact will automatically select the most recently used SpecsIntact printer, making it
easier to pick the correct printer for SpecsIntact printing and publishing.  The first time SpecsIntact 5 starts, it
will select the default Windows printer automatically.  SpecsIntact will also now issue a warning if no default
printer exists.

(CR 16-006)

Copy PDF Files To External Folder



When publishing Sections to PDF format, you may now save a copy of the PDF documents to an external folder.
 Specify this folder on the PDF Publish tab of the Print Processing dialog, by checking the option, Save copies to
this folder, and then browsing to any folder on your computer

(SPECSI-2762)

New Section Comments In Section Properties Dialog

Add and review comments for a Section in the Section Properties dialog, on the new Comments tab.  The SI
Explorer will automatically prepend to any new Section comment the date and user's computer login name, if
available.  When duplicating a Job or Master, you will now be able to choose whether you also wish to duplicate
the Section comments.

(CR 06-018, SPECSI-2841, and SPECSI-3075)

Customizable Review Status In Job Properties

The review status for a Job on the Schedule tab of the Job properties dialog is now customizable.  Choose one
of the traditional status options from the Review Status/Amendment Level dropdown, or choose the bottom,
blank option, and then type in a custom status or amendment level.

(CR 03-001)

Submit CCR For UFGS Section From SI Explorer Or Editor

SpecsIntact now makes it easy to submit a Criteria Change Request (CCR) for a UFGS Section.  After selecting a
UFGS Section in the right pane of the SI Explorer, select the option to 'Submit a UFGS CCR...' from the Tools
menu, or from the context menu available by right-clicking on the Section.  Alternatively, click the 'Submit CCR'
button in the Section Properties dialog box.  In the SI Editor, select the option to 'Submit UFGS CCR for Section'
from the Help menu while editing the Section.  Either option will direct your default web browser to the
appropriate CCR page for the UFGS Section.  If selected for a non-UFGS Section, these options will display the
UFGS page on the Whole Building Design Guide website.

(CR 10-020)

View Change And Revision History For UFGS Section From SI Explorer Or Editor

SpecsIntact also now makes it easy to view the Change/Revision history for a UFGS Section.  After selecting a
UFGS Section in the right pane of the SI Explorer, select the option Change/Revision History... from the Sections
menu or from the context menu available by right-clicking on the Section.  In the SI Editor, select the option
Changes/Revisions for Section from the Help menu while editing the Section. Either option will direct your
default web browser to the appropriate Change/Revision page for the UFGS Section.  If selected for a non-UFGS
Section, or from the Help menu in the SI Explorer, these options will display the main UFGS Changes and
Revisions page on the Whole Building Design Guide website.

(SPECSI-3137)

Open UFGS Web Page From SI Explorer

You can now open the UFGS page on the Whole Building Design Guide website in your default web browser by
selecting the option, Unified Facilities Guide Specifications (UFGS) from the SI Explorer's Help menu.



(SPECSI-3132)

Default File Name For Exporting Submittal Register Data Is UFGS4288

When exporting Submittal Register data, the SI Explorer will initially choose a default file name of UFGS4288,
but will also save and reuse the last file name chosen.

(CR 03-016)

SpecsIntact Adjusts For Missing Working Directories

To better support mobile computing, SpecsIntact will now detect and temporarily disconnect any missing
Working Directories, reconnecting them when they become available again.  Once SI automatically reconnects
them, the Working Directories will function normally.  SpecsIntact will still require at least one Working
Directory at all times, so having work more effortlessly.

(CR 09-019)

SpecsIntact Adjusts For Missing Masters

To better support mobile computing, SpecsIntact will now detect and temporarily disconnect any missing
Masters, reconnecting them when they become available again.  Once SI automatically reconnects them, the
Masters will function normally.  SpecsIntact will still require at least one default Master at all times, so having a
local Master will be required to take advantage of this feature.

(09-019)

SpecsIntact Saves Supplemental Reference File For Offline Use

SpecsIntact now will automatically save a copy of the Supplemental Reference file for use when the
primary Supplemental Reference file is unavailable.  Each time it starts, SpecsIntact will make a copy of the
main Supplemental Reference file, if available, or use the local cached copy if the main file is unavailable.

(CR 09-019)

Check For New UFGS Versions Without Checking For New Software

SpecsIntact now permits checking for newer versions of the Unified Facilities Guide Specifications (UFGS)
without also checking for new SpecsIntact software.  These two checks are now independently configurable
from the General tab of the Options dialog, available from the Setup menu.

(CR 09-019)

Create Sections From Section Templates In Default Or Primary Master

SpecsIntact now supports creating new Sections from Section templates contained in Masters.  SpecsIntact
will automatically make available any Section templates in the primary master for a Job, or the default Master
for any Master.  In conjunction with this, you can now copy existing Section templates to any Master.

(CR 14-004, SPECSI-3051, and SPECSI-3052)



SI Editor Displays Tags And Notes After Each UFGS Release

After each new UFGS release and SpecsIntact software installation, the Editor will automatically display tags
and specifier notes the first time it opens a Section.  After this, the Editor's tags and notes display will remain as
you set them.  Also, if opening a Section from Windows Explorer, rather than from a Job or Master, the Editor
will automatically turn on the use of Revisions the first time it opens a Section after a UFGS release or new SI
installation.  Job and Master Revisions settings will always override the Editor's Revisions setting, however, so
this change will not apply if opening a Section from a Job or Master using the SI Explorer.

(CR 16-004)

Restore Print Settings To Default Values When Renaming Or Duplicating Job Or Master

When renaming or duplicating a Job or Master, SpecsIntact now features the options to restore print settings to
default values.

(CR 01-041)

More Job Cover Page Formats

SpecsIntact now supports Job cover pages in PDF or Word file formats, in addition to the native SpecsIntact and
RTF formats available in previous versions of SpecsIntact.

(CR 09-006)

Job And Master Option To Identify Remote Section Location

To better support third-party file management applications, SpecsIntact now provides an option to specify the
location of Job or Master Section files being stored remotely outside SpecsIntact.  When you enter a remote
location for a Job's or Master's Sections, SpecsIntact will offer to try to open this location to verify that it is
accessible.  Specify a remote Section location on the Options tab of the Job or Master Properties dialog box.

(CR 15-003 and CR 15-008)

Processed Files Are Read-Only

SpecsIntact now creates processed files as read-only, to prevent accidental editing of these temporary
intermediate files.

(CR 07-010)

Single Change Request Folder For Each User Independent Of Working Directories

For simplicity and consistency, SpecsIntact now stores all saved Change Requests under a user's roaming profile
(e.g., C:\Users\USER_NAME\AppData\Roaming\SpecsIntact\Template\Comment Archive).  When SI 5 first
starts, it will attempt to copy all saved Change Requests to this folder, and will then automatically save
additional ones there.

 (CR 02-036)



Optionally Disable Submittal Wizard

The SpecsIntact Editor now features an option to disable the Submittal Wizard when inserting new submittals.
 The SpecsIntact team strongly recommends the use of the Submittal Wizard, but you may disable it by
unchecking the option, Use Submittal Wizard for inserting submittals, on the Edit' tab of the Options dialog,
available from the Editor's Tools menu. 

(SPECSI-2892)

More Consistent Mouse-Over Hint Text

SpecsIntact now features more consistent mouse-over hint text.  Pause your mouse cursor over most controls
in any dialog to display applicable hints.

(CR 04-021)

SI Explorer Indicates Locked Sections During Replacement

The SpecsIntact Explorer will now report Sections where errors occur during search and replace operations.
 The Explorer will no longer fail when attempting to replace terms in locked Sections.

(SPECSI-2828)

Technical Support Information

Users are encouraged to visit the SpecsIntact Website's Support & Help Center for access to all of our User
Tools, including eLearning (video tutorials), printable Guides, Knowledge Base containing Frequently Asked
Questions (FAQs), Technical Notes and Release Notes, and Web-Based Help.

CONTACT US:

 256.895.5505
✉ SpecsIntact@usace.army.mil
 SpecsIntact.wbdg.org

https://specsintact.wbdg.org/help-center
https://specsintact.wbdg.org/elearning
mailto:SpecsIntact@usace.army.mil?subject=SpecsIntact%20Technical%20Support%20Request
https://specsintact.wbdg.org/
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